
  

APRIL  2011
 Newsletter 

G l e n d o r a  S e n i o r s  C o m p u t e r  C l u b  

Volume 16 Issue 4 

A Friendly Seniors Group Serving All Computer Skill Levels 

General Meetings: 2nd & 4th Wednesdays of the month at 1:00 p.m. 
Board Meetings 2nd Wednesday of the month at 3:00 p.m. 

Photography 
By Rick Edwards 

PROGRAMS BY: Program Chair: 
Jim Glass(All programs subject to 

change) 

INSIDE THIS ISSUE 

Meeting Minutes   2 

Computer Classes   5 

WORD Tips               6 

Hacked email?               8 

Mac V. PC   10 

Service Packs   11 

MrModem   14 

 Q&A forms                17 

Officers & Chairs   18 

April 13th 

April 27th 

Online computer games 
Annemarie, Ell, Glen 

Happy Easter and a Wonderful Spring to Everyone ! 

 

We have had a great year at the Glendora Seniors 
Computer Club so far. 

Attendance has been wonderful, and the presenta-
tions interesting.  The classes are in full swing, so --- thank you to 
our teachers and presenters :Bill, Ell, Connie, Jeanine and Jim!  
And all the helpers behind the scenes.   

So much is happening in the technology world and with computers 
and in the wi-fi world  in particular, I feel blessed that we have an 
opportunity here with our Club to keep up and learn about some of 
the latest innovations.  Also, it is always good to learn from others’ 
experiences with purchases and equipment.   

I hope all who attended the last meeting learned enough about 
Skype to feel comfortable enough to use it. Please ask questions if 
you need any more help. The last half of the meeting time is always 
available for questions and problem-solving, as you know. 

Looking forward to Rick Edwards, the renowned photographer, 
again, and the opportunity to see some of his fantastic work.  And, 
the last meeting in April will be about a game site online that I 
would like to share with you, and more about games. 

Have a great April, and see you at the meetings ! 

Annemarie 

 

 Tax Day  April 15th 
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GSCC Meeting Minutes 
March 9, 2011 

Vice-President Connie Lang opened the meeting at 1:pm and welcomed members and 
visitors; there were 42 at the meeting today. 

Announcements:  

� Jim Glass reminded everyone of the upcoming Southwest Computer Conference 
June 3-5 in San Diego. 

� Ell Fullmer said a member’s Address Book had been hacked and many members re-
ceived a spam ad for a personal product. There has been an apology and one member has 
asked to be removed from our mailing list.  Steps have been taken to prevent the problem in 
the future. 

Jim Glass, Program Director introduced Bruce Aaronson 

Program: Personal Time Management: Getting 60 Minutes Out of 
Every Hour - By Bruce Carl Aronson, Free Lance Trainer /getting 
60 seconds out of every minute—techniques for getting more done in 
less time and have more time for the good stuff.  Some key points: 1) A 
Bucket List  2) Dealing with Distractions  3) The Big Question 
(WIBUOMTRN) What is the best use of my time right now?  4) Tips, Trips 
& Traps (procrastination, boredom, fear)  5) Where to from Here?  Mr. 
Aaronson’s program is available in booklet form, and for more information on the subject, 
Google “Time Management.” 

Jeannine Foote reported a follow up on her YouTube program from last meeting: She 
strung together videos on plumbing and saved herself $75 and then spent $125 at the chiro-
practor.  

Vice-President Lang thanked Wayne Gue and Barbara Denny for cookies today. Elea-
nor Rich, Ruthann Mayrose, Tom Millett will bring treats to our next meeting (3-23).    

Program for March 23rd will be a presentation on Skype by President Hunt. 

 

Education: Bill Belcher – Connie’s class on File Management begins tomorrow (3-10). 
Bill and Ell answered questions including updates and service packages for Windows 7. 
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Ell Fullmer: Talked further about the Hijack issue regarding the hacking of email address 
books, strongly recommending that Windows Live Mail and Gmail have the best spam fil-
ter,  and a lock box/Pass word Keeper to list all passwords as well as multiple email ad-
dresses and a temporary bank card number for purchases. 

 

Other - The 50/50 was won by Rita Norkin. 

Adjournment: 3:05 pm by VP Connie Lang 

Submitted by:        Approved By: 

Secretary Ruthann Mayrose     Vice-president Connie Lang 
 

 

GSCC Meeting Minutes 
March 23, 2011 

President Hunt opened the meeting at 1: pm and thanked VP Connie Lang for con-
ducting the last meeting in her absence. 

Minutes of March 9, were accepted with correction of Eleanor English bringing 
cookies today. 

Announcements: Education Chair Bill Belcher is on vacation and President Annemarie Hunt 
and Tech Advisor/Webmaster Ell Fullmer will present today’s program and demonstration on 
Skype. 

 

PROGRAM Chair-Jim Glass: The Southwest Computer Conference is coming up (June 3, 
4, & 5) in San Diego—check the website www.theSWCC.org for details  

Today’s program--Skype – Annemarie Hunt & Ell Fullmer 

Annemarie showed us all the hardware she uses for Skype and demonstrated how Skype 
works with a call to her brother in Germany.  She emphasized that it is free, or very low cost 
for international—cost of the call to Germany; approximately $.04.. Computer-to- computer, 
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Skype is always free, even international.  The only time Skype charges is when a computer 
calls a landline, and then it is about 2 c/minute to Germany, for instance.  You can call any 
phone number that way, and there are different charges, depending on where you call. 

Ell: Three things necessary for Skype operation—1) A Computer; 2) The Software available 
on line for free; 3) A camera (Smartphone or webcam)—most new lap tops are equipped with 
built-in webcam.  He demonstrated how to access and download Skype Software and called 
his son Darren in Rising City NE. 

Skype is available for both PC & Mac with Audio and video, as well as text messages. Google 
Skype for information on software etc. 

Program for April 13th will be Rick Edwards-photography; April 27th will be Computer 
Games On-line (Annemarie, Glen & Ell). 

Education: Connie Lang-Internet and Email class is still in progress; June classes will be Ba-
sic Computer Skills. 

 

Ell Fulmer, Annemarie & Jim Glass answered Problem Questions including: 1) Information 
on antivirus programs; 2) Storing backup information in three places a) hard drive b) offsite-
disc or    c) an external hard drive. 

Pres Hunt thanked:  Eleanor English & Ruthann Mayrose for today’s treats.  Leroy 
Overstreet and Tom Millett will bring cookies for April 13th meeting. 

Other - The 50/50 was won by Donna Hinman. 

Adjournment: 3:00 pm 

Submitted by:        Approved By: 

Secretary Ruthann Mayrose     President Annemarie Hunt 

Thanks for bringing  cookies 
for the March 9th meeting: 

Wayne Gue 

Barbara Denny 

Thanks for bringing cookies 
for the March 23rd meeting: 

Eleanor English 

Ruthann Mayrose 
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Computer Classes for 2011 

Note: All classes are held in the Elm Room of the LaFetra 
Center 

Minimum enrollment required – 5 students for each 
class offering 

  
  

June and July – Basic Computer Skills 
If you are new to PCs or have been using a PC for a while but want to use it more 
effectively, then this 8 week course is for you. We will cover the fundamentals 
starting with how to turn the PC on and off, keyboard and mouse usage, installing 
and uninstalling applications, beginning word processing, as well as proper file 
management and maintenance. We will demystify some of those confusing boxes 
that pop up unexpectedly and throughout the course, we will use the language of 
computers so that you can understand and even speak a little geek. 

When: Thursdays, June 9 through July 28 – 1:00 to 3:00 PM 
Class fee: $40.00 paid at least one week prior to start of class. 
Limited to 12 students 

The student must have access to his/her own computer and be prepared to prac-
tice the techniques learned in this class for at least two hours each week. 

June and July – Advanced Photoshop Elements 
Taking the digital darkroom one step farther, this 8 week class will explore ad-
vanced layering techniques, brushes, filters, and automation techniques. 

When: Tuesdays, June 7 through July 26 – 1:00 to 3:00 PM 
Class fee: $40.00 paid at least one week prior to start of class. 
Limited to 12 students 

The student must have a Windows computer, a scanner and printer, and Adobe 
Photoshop Elements 6 or later software. The student should be familiar with the 
techniques taught in the digital darkroom class  
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(Excel) 

Copying Values 
There are many ways that you can use Excel's tools to fill out various cells in a worksheet. 
One of the most common tools is to copy a cell (or cells) and then paste them into other cells. 
The only problem with this approach is that when you copy cells, you also copy the format of 
the original cells into the target cells. What if you just want to copy the values from the origi-
nal cells, but retain the formatting already applied in the target cells? 

You probably already know that you can use the Paste Special option from the Home tab of 
the ribbon (Excel 2007 and 2010) or the Edit menu (older versions of Excel), and then 
choose the Values option to paste just the values. If the target cells are right next to the origi-
nal cells, there is an even easier way to accomplish the same task. Simply follow these steps: 

1. Select the original cells whose values you want to copy. 
2. Right-click on the fill handle (at the bottom right-corner of the selection) and drag the 

selection to encompass the target cells. When you release the mouse button, a Con-
text menu appears. 

3. Choose the Fill Values option. Excel fills the target cells with the values from the 
original cells; the formatting remains unchanged. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thou-
sands of free Microsoft Excel tips can be found online at http://excel.tips.net. 

The Computer Guys, Bill Belcher & Ell Fullmer, will be meeting 
on the  

SECOND Thursday of the month:  

  April 14 

9:00 a.m. to 12 noon — Second Floor — La Fetra Center 
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Word 2007 

Inserting the User's Address 
Word automatically maintains several items of information about you, as a user. One such 
item is your address, which is changed on the User Information tab of the Options dialog 
box. If you want to automatically insert the user address in your documents, you can follow 
these steps: 

1. Position the insertion point where you want the address inserted. 
2. Make sure the Insert tab of the ribbon is selected. 
3. In the Text group, click Quick Parts. You’ll see a drop-down menu. 
4. Choose Field. Word displays the Field dialog box. 
5. In the Categories drop-down list, choose User Information. 

 
The Field dialog box. 

6. In the Field Names list choose UserAddress. 
7. Click on OK to close the dialog box and insert your field. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted by permission. Thou-
sands of free Microsoft Word tips can be found online at http://word.tips.net. 
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 E-mail Hacked? An Ounce of Prevention… 

By Lee Seidman, Vice President, Business and Professional Microcomputer Users 
Group, Inc. (BPMUG), CT 

February 2011 issue, The Help Key 

Man (at) yahoo.com  

www.bpmug.org 

 

Recently, some unsuspecting e-mail users may have experienced dismaying and 
shocking notifications suggesting that his or her e-mail has been hacked and used to 
send spam (or worse), even if the e-mail system is web-based rather than 
downloaded directly to one’s computer via a local application like Microsoft Mail, 
Outlook, Outlook Express, MacMail, Entourage, Thunderbird, etc. (and hence, sus-
ceptible to operating system-level vulnerabilities). The primary suspect is the pass-
word used to access the account.  

  

People tend to try to keep things simple by using the same password to access a va-
riety of sites, but at the risk of security. People’s e-mail account password should 
never be used for any other account or web site. Generally, e-mail can be compared 
to a postcard; although the message is destined for a particular recipient, it has the 
potential to be read by anyone as it traverses the Internet. Additionally, if one joins a 
web site that requests a password to subscribe, a confirmation e-mail is often gener-
ated clearly presenting the username (often an e-mail address) and the proper pass-
word.  The postcard analogy applies to that non-encrypted e-mail – it is open for 
anyone to read.  A typical malicious-minded hacker (the “Black Hat”) who either in-
tercepts that e-mail or accesses that web site’s consumer database would first at-
tempt to use that password associated with that e-mail address to access the e-mail 
account. For example, if someone is whomever@aol.com registers to join a commu-
nity web site or message board site-whatever.com, generally he or she is asked to 
use his or her e-mail address as the user name. Site-whatever.com will ask the per-
son to generate a password and often will send a confirmation e-mail identifying the 
username and password in clear text (meaning it is not obscured). The first thing a 
third-party (in other words, someone who is not the subscriber or a representative of 
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the web site) may try to do is use the password contained in that e-mail to access 
homever@aol.com itself.  

 

Once a hacker with bad intentions gets into the e-mail, he or she may start slowly to 
not get noticed, however, it does not require much effort for the “Black Hat” to 
change  the password AND security questions (for password resets) to effectively 
lock the account owner out of his or her own e-mail. If nefarious activity is suspected 
to take place with one’s e-mail account:  

  

• Inform those in your contact list of the circumstances, preferably by voice or an 
alternate e-mail account and make sure they understand not to engage the 
questionable content (usually seeking money in one form or another – espe-
cially via embedded hyperlinks); get as much help to act as quickly as possible 
as time is of the essence and everyone in that contact list is potentially at risk 
since they  trust the e-mail is coming from you when in actuality it does not  

• Change the password to access the e-mail account (and make it complex and 
very difficult to guess)  

• Change the security questions to change the password  
• Notify the e-mail provider  
• If this is a commonly used password for online financial  transactions (banking, 

purchasing, etc.), change the password for those e-commerce sites  
• Keep all correspondence between the “Black Hat” and any contacts as evi-

dence  
• If money is involved, contact local and federal authorities at the Internet Crime 

Complaint Center (http://www.ic3.gov/default.aspx), especially if the “Black 
Hat” actually defrauded someone out of money. 

   

In general, it is a good idea to have an e-mail account for personal correspondence 
count and a separate one for web-based subscriptions (or use a temporary/
disposable e-mail address offered by the majority of providers). The key is to use 
distinct passwords; the online world can be a dangerous place in which to operate, 
but one’s own behavior usually determines the level of jeopardy one will risk in such 
an environment. A little forethought can prevent a whole lot of hind-sight consterna-
tion. ****   
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 Mac vs PC - How Do You Decide? 

By Abby Stokes, Author, Is This Thing On? 

www.abbyandme.com 

abbystokes (at) yahoo.com 

  

I'm regularly asked "Should I buy a Mac or a PC?" It's a battle not unlike the Hat-
fields vs the McCoys. For those of you that don't know the difference, a Mac/Apple 
(the name is interchangeable) is one manufacturer of both laptop and desktop com-
puters. The inside (operating system or the brain) and the outside (hardware or what 
you touch) are both designed by Apple. A PC is every other manufacturer of the out-
side of a laptop or desktop computer (HP, Sony, Dell, etc.) with the operating system 
manufactured by Microsoft. 

The answer to the question "Should I buy a Mac or a PC?" is a question: "Who will 
you call for help on Sunday afternoon when something goes wrong with your com-
puter?" Your computer lifeline needs to understand the kind of computer you have. 
So, if your computer lifeline is your neighbor, your daughter, or your friend next door, 
purchase a PC or Mac according to what they use. You don't need to buy the exact 
model they have, but you'll want to buy a computer that they understand and can 
help you with. 

Let's call a spade a spade. I've been teaching computers for 17 years, and I can say 
with complete confidence that NO COMPUTER is "user-friendly." That is just damn 
good marketing. That doesn't mean you can't learn to use a computer, whether it is a 
PC or a Mac, but there's very little about any computer that is intuitive or friendly. 
Once you understand some of the techniques necessary to operate it, the computer 
becomes more intuitive in the same way that driving a car becomes intuitive, but it 
isn't any thanks to some of the design choices. Who was the genius that put the 
Caps Lock key so close to the Shift key? What is the logic of clicking Start to turn off 
the computer? I could go on... The upside is, like a car, the computer can bring you 
to wonderful places making it worth the effort to learn how to operate it. And, like a 
car, you don't need to understand the nitty gritty of how it works in order to work it. 

It's true that a Mac is less vulnerable to viruses. That is a definite plus. And it can be 
argued that the inside of a Mac may have been or still is better, lusher, or more ad-
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vanced than a PC, but you and I won't ever notice the difference. If you're a graphic 
designer, a Mac is probably a better idea. For us, the average user, both a Mac and 
a PC will equally meet our needs with e-mail, word-processing, and the Internet. If 
you're comfortable with whichever kind of computer you already have, there's no 
reason to succumb to pressure because someone you know LOVES their Mac or 
PC. Will they be there to help you when with a computer question or problem? 

If you decide to change from PC to Mac or vice versa, you can make the transition 
with the same patience required with a new spouse. There'll be good days and bad 
days, and eventually you'll hit a comfort level with all the changes. A different operat-
ing system does require that you purchase all new software which can be pricey. Re-
search the cost of whatever software you have on your existing computer before 
you make the change. 

No matter the pressure or hard sell that comes your way, your computer choice is 
YOURS to make. Hold fast to what suits your needs, wallet, and comfort level. Tell 
them I said so! 

For more on Mac vs PC visit Chapter 6 (p. 47) in "Is This Thing On?" A Computer 
Handbook for Late Bloomers, Technophobes, and the Kicking & Screaming 

 Service Packs Explained (and needed) 

By Sandy Berger, Compu-KISS 

www.compukiss.com 

sandy (at) compukiss.com 

Although most of us still think of Windows 7 as a brand-new operating system, it is, 
in fact, starting to show its age. Windows 7 made its debut on October 22, 2009. Is 
one and one-half really old? Well, in the computer world, it is not old, but it is cer-
tainly full-grown. One sign of this is that Microsoft has just released the first Service 
Pack for Windows 7. 

A service pack is a collection of updates, bug fixes, and enhancements for a soft-
ware program. As you know, Microsoft routinely offers updates for their Windows op-
erating systems.  These updates come out weekly, and they patch or, you might say, 
repair the operating system so that they remain safe from hackers. They can also in-
clude improvements or enhancements to the operating system. At a certain point in 
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time, Microsoft gathers all of those updates, adds any other updates and enhance-
ments they have and issues this batch of updates as a service pack.  It is also impor-
tant to note that when Microsoft issues a service pack, this service pack also makes 
sure that all of the updates and enhancements work well together and offer good sta-
bility for the operating system. 

 

The question that I am most often asked is this, "If I have installed every update that 
Microsoft has released, do I still need to install the service pack?" The answer is 
"yes." Often the service pack contains additional updates and/or enhancements that 
were not included in the weekly updates. Also, a service pack makes sure that all of 
the updates are put together properly to make your system run well. 

in fact, Microsoft thinks that this is so important that they only support the operating 
system when it has the proper service packs installed. Each service pack should be 
installed when it is released. If, for some reason, they are installed all at the same 
time, each is installed sequentially. 

So, for Windows XP you should have Service Pack 3 installed. Windows Vista 
should have Service Pack 2, and Windows 7 should have Service Pack 1. To learn 
what service pack you have installed, just click on the Start button, right-click on Com-
puter or My Computer, and then click Properties. You will see the service pack listed 
under the Windows edition. 

You can go to the Microsoft website and install a service pack from there, if you hap-
pen to be missing one. All service packs from Microsoft are free. If you are using Win-
dow 7, the new service pack will be offered to you through Microsoft's automatic up-
date service. This Windows 7 service pack can take up to 30 minutes and will re-boot 
your computer. I have installed Window 7, Service Pack 1 on several computers with-
out a problem, but you should be aware that installing a service pack is a big update. 
Microsoft recommends that you back up your computer before installing a service 
pack. And to be honest, you should be backing up your computer anyway. So if you 
don't have a backup strategy in place, this is a good time to implement one. 

The newest version of Internet Explorer - IE 9 is now in testing and it is already avail-
able for free download in a beta version. This is by far, the best version of Internet Ex-
plorer that Microsoft has ever released. IE 9 won't run on Windows XP; it requires 
Windows Vista or Windows 7. Although Microsoft is not requiring Windows 7 Service 
Release 1 to install IE 9, it is advisable to install this Service Release before you in - 
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stall IE 9. 

Service Packs are a fact of life for Windows users. Installing them may be a bit of 
a pain, but you really need them to make sure that your Windows system is se-
cure and stable and that it performs well. 

The Donation 
 
Father O'Malley answers the phone. 'Hello, is this Father O'Malley?'  
'It is!'  
'This is the IRS. Can you help us?'  
'I can!'   
'Do you know a Ted Houlihan?'  
'I do!'  
'Is he a member of your congregation?'  
He is!'  
'Did he donate $10,000 to the church?'  
 
'He will.'   

Son:       'Mum, when I was on the bus with Dad this morning, he told me to 
give up my seat to a lady.'    
 
Mom:    'Well, you have done the right thing.'    
 
Son:       'But mum, I was sitting on daddy's lap.'    

Senility 
 
An elderly man went to his doctor and said, 'Doc, I think I'm getting senile.. Several 
times lately, I have forgotten to zip up.'  
'That's not senility,' replied the doctor. 'Senility is when you forget to zip down.'  
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 Ask Mr. Modem! – April 2011       
www.MrModem.com     
 
 
Stubborn Magnifier Creates Oversized Problem  
 
Q.  I was excited to try the Windows Magnifier to help me read small print, but now I 
can’t get rid of it. I’ve tried everything I can think of, but it won't disappear. How can I 
close it once and for all? 
 
A.  For those who aren’t familiar with the Magnifier, Microsoft's somewhat verbose descrip-
tion is, “a display utility that makes the computer screen more readable by creating a sepa-
rate window that displays a magnified portion of the screen.” Succinctly stated: It makes 
things larger.  
 
To launch the Magnifier in XP, click Start > All Programs > Accessories > Accessibility > 
Magnifier. In Vista and Windows 7, click Start and in the Search field, type “Magnifier.” 
 
To close the Magnifier, look for its icon on the Taskbar, at the bottom of your screen. Right-
click that icon and select Close.  
 
 
Q.  I have a belt clip for my iPod that has a little flap cover that is held shut with a mag-
net. Could this magnet destroy all the songs I have in my iPod? Am I heading for a data 
disaster? 
 
A.  It's highly unlikely that it will cause any problems. There are never any guarantees, of 
course, but magnets capable of wiping out data are very powerful, not the type that would be 
associated with a magnetic closure of the type you describe. I wouldn't have any qualms 
about wearing a stylish iPod belt clip (from the spring Nerdwear collection, I'm guessing), 
and if you haven't had any problems thus far, you're not likely to have any in the future. 
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Q.  I have a Word document that was typed in ALL CAPS. I know that to get lower case 
I can click Insert and re-type the letters to change each word, but is there some way I 
can change the entire document at once? I tried the Find/Replace command, but that 
did not work. Thanks in advance for any suggestions you may have. I love your weekly 
newsletter. 
 
A.  Select (highlight) the text you want to change, then press SHIFT + F3 and keep pressing 
it to toggle between ALL CAPS, lower case, and Initial Caps. 
 
 
Q.  I had to install a new ink cartridge today, but I wanted to skip the print-testing 
pages because it wastes paper and ink. Nothing I tried worked. Is there any way to 
avoid that or am I caught in the ugly grasp of my printer? 
 
A.  Unless the ability to bypass that function exists with your particular make and model 
printer, which you did not identify, in most cases there is no way to avoid that. Generally 
speaking, that type of print-and-align function is truly not a waste of paper and ink in the 
long run. This function enables your printer to continue to provide the best print quality pos-
sible.  
 
I have several printers here, and when I replace ink cartridges, it is accompanied by a sym-
phony of beeps, boops, clanks, clunks and printing pages. As a card-carrying geek, I am of 
course obligated to examine the test-print sheets to confirm that everything is printing cor-
rectly. Not one to waste anything, I then use the test sheets as scrap paper to record my pithy 
thoughts or compose ransom notes, as needed. I would suggest going with the ink flow and 
be happy your printer is monitoring itself and maintaining its print quality. 
 
Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month  
 
Abandoned Rails 
Railroad lines have a unique and fascinating history. For better or worse, thousands of miles 
of track have been abandoned in the U.S. during the last 30 years. This site is dedicated to the 
preservation of the history of former railroad lines through interesting facts, pictures and arti-
cles. All-abooooaaaarrrrrrrd! 
www.abandonedrails.com 
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Nation History 
Geography buffs and world travelers will enjoy this site’s concise histories of every country 
and non-sovereign territory on the planet. You can search for a specific nation by name or 
just browse its six regions: Africa, Asia, Europe, North America, Oceania, and South Amer-
ica.  
www.historyofnations.net 
 
Universcale 
If you have ever been to a planetarium, studied astronomy, or looked at the sky on a cloud-
less night, you know that the size of the universe is impossible to comprehend. In fact, if you 
think about it too intensely it can cause your head to explode. Universcale is a site that serves 
as an "infinite yardstick," placing objects into a scale that provides a better idea of the true 
vastness of the cosmos. It is an interesting online experience to watch the ever-expanding 
scale bring some perspective to the extremities of space, where the outer limits of the uni-
verse are an equally incomprehensible 100 billion light years away. Sit back, relax, and allow 
plenty of time for this Nikon-sponsored moving scale to display.   
http://tinyurl.com/592jkh 
 
For plain-English answers to your questions by email, plus great computing tips, sub-
scribe to Mr. Modem’s award-winning WEEKLY newsletter. Subscribe using Promo 
Code 1046 and receive a free month (four weekly issues!) with your six-month subscrip-
tion. To view a sample issue or subscribe, visit www.MrModem.com.   

 

Brothel Trip 
 
An elderly man goes into a brothel and tells the madam he would like a young girl 
for the night.  Surprised, she looks at the ancient man and asks how old he is.  
 
'I'm 90 years old,' he says.  
 
'90!' replies the woman. 'Don't you realize you've had it?'  
 
'Oh, sorry,' says the old man. 'How much do I owe you?'   
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DO YOU HAVE A QUESTION FOR OUR TECH GUYS, BILL BELCHER & ELL FULMER? 

Fill Out the Form Below & Bring it to the Meeting 

 

Name: ______________________________________________________________________________________________ 

 

Cptr Operating System      Windows 98   ___  Windows XP   ___  Windows Vista  ____ Windows 7 ______ Mac___ Other____ 

 

Question:_________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

 



 

333 East Foothill Blvd. 
Glendora, CA 91741  
Telephone: (626) 914-8235 

All opinions herein are those of the individual authors only, and do not necessarily reflect the opinion of the GSCC. The GSCC does 
not endorse, rate or otherwise officially comment on either products, services or vendors. Readers are cautioned to rely on the opin-
ions presented at their own risk and discretion.  

The GSCC, its editorial staff, and its contributors assume no liability for any damage arising out of the reliance upon any published 
article. 

Articles are compiled without verification of accuracy or applicability of accuracy or applicability of any article. 

We’re On The Web  
Webmaster:  
Ell Fullmer 

www.gscclub.org 
Email:  

gscc(at)gscclub.org 

Elected Officers 

Committees & Chairpersons 

Have a New  

Email Address?  

Please Notify Membership 
Chair: Jeannine Foote  

jeanninefoote(at)
yahoo.com 

Thank you to the following mem-
bers for help in this   

 month’s Newsletter: 

  

  

  

 

Program Director            Jim Glass  jglass1001(at)aol.com 

Asset Management       Glen Moore mooretours(at)earthlink.net 

Membership  Chair      Jeannine Foote  jeanninefoote(at)yahoo.com 

Public Relations        Leroy Overstreet lpover(at)hotmail.com 

Nominations                

Programs Chair            Jim Glass jglass1001(at)aol.com 

Webmaster                     Ell Fullmer pakratt(at)gmail.com 

Education                       Bill Belcher billbelcher(at)gmail.com 

Newsletter Editor     Dan Leddy ranchitoave(at)yahoo.com 

Set-Up Chair                   Bill Hart Bobbibill(at)peoplepc.com 

Please submit Newsletter Arti-
cles by the last Friday of the 

Month.  

Type GSCC in Subject Line. 

Email to Dan Leddy 

ranchitoave(at)yahoo.com 

President                Annemarie Hunt ajhunt1447(at)aol.com 

Vice President Connie Lang connielang(at)verizon.net 

Secretary Ruthann Mayrose Ruthannmeister(at)gmail.com 

Treasurer                Rose Marie Diem catscobwebs(a)charter.net 

Tech Advisor  Ell Fullmer pakratt(at)gmail.com 

Past President—Annemarie Hunt Ajhunt1447(at)aol.com 


